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End-User License Agreement (EULA)

This End-User License Agreement (EULA) represents the contractual conditions 
between you, the Licensee, and UVI, located 159 rue Amelot, 75011 Paris - France for 
the use of software, documentation and other materials created by UVI. 

You should not register, install or use UVI Products until the following license 
agreement is understood and accepted.

By using UVI Products, or allowing anyone else to do so, you are accepting this 
agreement. 

A- License Grant
1. UVI grants to you, subject to the following terms and conditions, the non-exclusive 
right to use each authorized copy of the Product.

2. UVI Product license are granted only to a single user. You may use this product on 
up to three separate computers or iLok Dongles, which shall be owned and used by 
you exclusively. 

3. Renting or lending the licensed Software to a third party is expressly forbidden. 

4. Except if otherwise stated within this EULA, Licensee may resell the software to 
a third party or transfer the software permanently. Request may be done using the 
‘Transfer License’ feature in your iLok account, subject to a $25 fee per-license ($50 
maximum) by Pace. The serial number of the Product will be transferred to the third 
party by UVI, and  Licensee’s original registration will be deleted.

5. Resale or ownership transfer of individual products obtained in a bundle, or those 
used to upgrade or cross-grade to other products are not allowed.

6. UVI allows you to use any of the sounds and samples in the products you’ve 
purchased for commercial recordings without paying any additional license fees or 
providing source attribution to UVI.

7. This license expressly forbids resale or other distribution of the sounds and software 
included in the Product or their derivatives, either as they exist on disc, reformatted 
for use in another digital sampler, or mixed, combined, filtered, resynthesized 
or otherwise edited, for use as sounds, multi-sounds, samples, multi-samples, 
wavetables, programs or patches in a sampler, microchip or any hardware or software 
sample playback device. You cannot sell the Product content or give it away for use by 
others in their sampling or sample playback devices. 

8. In the event UVI terminates this agreement due to your breach, you agree to return 
the original and all other copies of the software and documentation to UVI.

9. UVI reserves all rights not expressly granted to herein.

B- License Activation
1. In order to use UVI Products it is required that you authorize them by registering 
your Serial Number on uvi.net/register, have a free iLok account (not necessarily 
a dongle) and install the free iLok License Manager (done automatically by UVI 
Workstation and Falcon installers). It is impossible to use UVI Products if they are not 
registered and authorized.

2. During authorization you will need to enter your name, email address and postal 
address which will be stored in the UVI database. UVI uses a secure SSL connection 
with 128-bit-encryption that meets current security standards to transmit your data 
over the web. For further information about UVI’s handling of personal data please see: 
https://www.uvi.net/privacy-policy

3. The UVI Product license allows up to 3 simultaneous activations on any combination 
of iLok dongles and computers. Activations can be moved between devices at anytime 
through the iLok License Manager.

C- Protection of Software
You agree to take all reasonable steps to protect the Product and any accompanying 
documentation from unauthorized copying or use. You agree not to modify the 
Product to circumvent any method or means adopted or implemented by UVI to 
protect against or discourage the unlicensed use or copying of the Product.

D- Ownership
Ownership of, and title to, the enclosed digitally recorded sounds (including any 
copies) are held by UVI.
Copies are provided to you only to enable you to exercise your rights under the 
license.

E- Term
This agreement is effective from the date you open this package, and will remain in 
full force until termination. This agreement will terminate if you break any of the terms 
or conditions of this agreement. Upon termination you agree to return to UVI all copies 
of this product and accompanying documentation and destroy any other copies made.

F- Restrictions
Except as expressly authorized in this agreement, you may not rent, lease, sub-license, 
distribute, copy, reproduce, display, modify or timeshare the enclosed Product or 
documentation. 

G- NFR Serials and Free Products
UVI Products serial numbers labeled as “NFR” (Not For Resale) shall only be used for 
demonstration, testing and evaluation purposes. NFR Products may not be used for 
commercial purposes, and may not be resold or transferred.
They are not eligible for license recovery and are exempt from update, upgrade 
or crossgrade offers, and cannot be purchased with or exchanged for vouchers. 
Furthermore, as an owner of an NFR Product, you are not entitled to promotions 
available for the commercial version of the Product.

H- No Support Obligation
UVI will make its best effort to support you in the event of technical difficulty with a 
UVI Product. However, UVI is not obligated to furnish or make available to you any 
additional information, software, technical information, know-how, or support.

I- Specifications and System Requirements
All technical specifications of UVI Products provided are intended to be estimates 
or approximations. Due to numerous variables no guarantees of compatibility or 
performance can be made. All such specifications shall be in writing.
End-User is solely responsible for, prior to purchase, ensuring that End-User’s devices 
are compatible and meet the system requirements for UVI Products, and that the 
applicable UVI Products meet End-User’s requirements.

This EULA is governed by the laws of France.

 

©2017 UVI. All rights reserved.
All trademarks are the property of their respective owners.

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.



3

Introduction ............................................................................................................................4

DZmo

     Interface .............................................................................................................................5

     Preset List .........................................................................................................................6

DK5S

     Interface .............................................................................................................................7

     Preset List .........................................................................................................................8

DS-890

     Interface .............................................................................................................................9

     Preset List .........................................................................................................................10

Links ...........................................................................................................................................11

Credits and Thanks ..............................................................................................................12

Table of Contents



4

Introduction

Digital Synsations Vol. 2
The late ‘80s and early ’90s was a time of great 
technological change, ushering in the digital-era and 
bringing with it exciting new possibilities. Over the years 
a legion of digital synthesizers appeared from all across 
the world, reforming the very idea of what a keyboard 
could do. Equipped with new and innovative synthesis 
techniques, these machines would forever change our 
sonic landscape and lay the groundwork for the modern 
software instruments and effects that we use today. 
Digital Synsations Volume 2 is the next step in our 
journey to revisit and preserve these revolutionaries, 
exploring the capabilities and unique character of 3 
digital synths from the ‘90s.

Minimum System Requirements

• UVI Workstation 2.6.10+ or Falcon 1.2.1+

• 18.25GB of disk space

For more information on the installation process, please refer to 

the document: Soundbank Installation Guide

http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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DZmo - Interface

2Amplitude

1Mono / Poly

3Filter

6Stereo

4 Pitch

5 Drive

7 Bit Crusher

8 Effects

9 Modwheel

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel > Atk

Remaps Attack to Note Velocity

» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filter envelope

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento

» Time

Sets the glide time

5  Drive
» On/Off Switch

» Amount

Sets the drive amount

6  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [Width]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width (ALT mode)

» Detune

Detunes the unison layers (UNI mode)

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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DZmo - Preset List

Bass

 Agni Maya AN

 aLo Bass AN

 Calvin Bass

 Fatable One

 Funkzmo 1

 Funkzmo 2

 Funkzmo 3

 Mini Lazer Harp

 Modularperc

 Organ Bass

 Polykeys Bass

 Roombass

 Round Up

 Saw Bass Tea

 Square Face

 Warmer

 Weirdo Bass

 

Bells

 Clearnet X Bells

 Dark Mood

 Fizmabell

 JazzMBell

 LFO Montbello

 Musoc Bix

 Pacques Beau

 Space B3ells

 Sporting Bell

 Standard Bell

 Transwave Bell 1

 Transwave Bell 2

 Transwave Bell Keys

 

Brass

 Brass Analozmo

 Fiz Brass

 Funk 80s

 HyBrassid

 Limit Five

 Movie Brass

 So Brassizmo

 Soft Table

 Sporting Horns

 Sweep B

 Transbrass

 

FX-Weird

 Bi Portamento

 Drunk THX

 Evolutione

 Fizmotron

 FXmo

 Little Zap

 Transwave Beach

 Wind Transfert

 

Keyboards

 Cindy Lau

 Clavisonic

 FizmOrgan

 Giorgo Lamani

 JazzMOrgan

 Movie Show Keys

 Muktivada AN

 Polykeys

 PulsoClavo

 Soft Mood Keys

 Space B3

 Transwave Keys

 Wurlizmo

 

Leads

 aLo Solo

 Analozmo

 Fatablead

 Formant Solo

 Funkzmo Lead

 Inclassablead

 Lead Artifact

 Pulsolo

 Pure Translead

 Roomsolo

 Saw Sai Tea

 Scream Vox

 Soft Translead

 Solo Brassizmo

 Solo Maya

 

Pads

 Bubble Gum

 Clearnet X

 Crystal Storm

 Digital Pad

 Explorer AN

 Fifth Dimension

 Galactipad

 LFO Mont

 Mirage AN

 Mutable Waves

 Peach Pad

 Saint Petersbourg

 So Padizmo

 Soft Transpad

 Sporting Pad

 

Polysynth

 Bi Polysynth

 Dirty Five

 Keysoft Pix

 Phatzmo

 Poly Artifact

 Poly Sporting

 Soft Fizme

 Stax Nalog

 

Seq

 Arbalette

 Fifth Seq

 Mellow Seq

 Modular Short

 Seq Vox

 Soft Corn

 Square Short

 

Strings

 Agni Klana AN

 Fizmicato

 Interfizmo

 Movie BrasStrings

 Phatzmood

 Pure Transtring

 Sad Analog

 String Max In

 Thin Digital

 Transominous Waves

 

Sweeps

 Aurora AN

 Bass and Sweep

 Casus Belly

 Digital Sweep

 Fantasmogorix

 Lead Sweep

 Sport Sweep

 Sweep Table 1

 Sweep Table 2

 Swhithles

 Transphonic

 

Tempo Synced

 Active Step

 Agotra AN

 Chaos Sporting

 Deepology AN

 EFX Arena AN

 Guimberlum

 Moving Pad

 Moving Stack

 Paramatrix

 ParaPadrix

 Pulsar AN

 Pulsar Solo

 Realtime Waves

 Soft Wooble AN

 Spacial Lounge

 Transmutable

 Voxus Belly

 Voxus Soli

  

Vocals-Formant

 Analog Mood

 Choir Formant

 D50 Vox Like

 Digital Kortex

 Doozmo 1

 Doozmo 2

 Formant Keys

 Hybrid Vox 1

 Hybrid Vox 2

 Inclassablvox

 Narrow Fields

 Phonemoid

 Pluck In

 Scream Pad

 Sporting Voices

 Sweep Formant
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DK5S - Interface

2Amplitude

3Filter

4Pitch

8 Effects

6 Stereo

7 Bit Crusher

1 Mono / Poly

5 Drive

9 Modwheel

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel > Atk

Remaps Attack to Note Velocity

» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filter envelope

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento

» Time

Sets the glide time

5  Drive
» On/Off Switch

» Amount

Sets the drive amount

6  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [Width]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width (ALT mode)

» Detune

Detunes the unison layers (UNI mode)

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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DK5S - Preset List

Bass

 Acid Box

 Bottle Bass

 Classic Analog

 Clic Sub 1

 Clic Sub 2

 Clic Sub 3

 Filter K

 Funky Like

 Gorilla

 House Club

 Micro TB

 Phat Grain

 Pop Funk

 Power Town

 Subcon

 Syncrhotron

 Taurusing

 Tubadditive

 X Clubass

 Zapp Mood

  

Bells

 Basicell

 Breathing Bells

 Clickopolis

 FantasiaK

 Feerique

 High Liasing

 Hybrid Jazz Bells

 JD Elec Piano Bell

 Knalog Bells

 Mat Swing

 Monte Christo

 Road Tines

 Sine B

 So Eighties

 Talking Bell

 Think Glass

 Tubel Air

 Ultra Soft Digit

 Vox Bell

  

Brass

 Car 5000

 Cosmo Brasses

 Frenchy Horn

 Ghost Brasser

 Mixed Brassy

 Movin Brass

 Obie 5K

 Prophet 5K

 Sax Additive

 Synth Brass 1

 Synth Brass 2

 Van Allen

 Xilhornphone

  

FX-Weird

 Cyber Mosquito

 Digital Jungle

 ice Land

 In Da Space

 Marry Poppins

 Multi FX

 Sixth Dimension

 Underground

  

Keyboards

 Additive Tines

 Dirty Darkeys

 DKlavinet

 DX Guitines

 Dyno Vibes

 FM Tiny

 Harpsy Dre

 JD Elec Piano

 K5lavinet

 Melancolikeys

 Modern EP

 Numerhodes

 Piananalog

 Steady Road

 Suitcase Ditive

 Super Pmart

 Synth Keys

 Toys Add Piano

 Wurly DKS 1

 Wurly DKS 2

  

Leads

 Bottle Lead

 FeedBackin

 Lead Clic Sub

 Micro TB Lead

 Nicolead

 Picky Lead

 Subcon Lead

 Supra Funky

 Synchrotron Lead

 Taurusing Lead

 Wah Solo

  

Organs

 Charlie Oled

 Clear Organ

 Full Space Organ

 Happy Days

 Hybrid Jazz

 Mellorgan

 Organ House 1

 Organ House 2

 Organ Vib

 Orgatack

 Process B3

 Pure Ham 1

 Pure Ham 2

  

Pads

 Basic Padd

 Calm Field

 Composite Bed

 Deep Field

 Fantasiadditive

 Jun Orange

 Layer Bright

 Mad O Five

 Mini Overture

 Movin Pad

 Orbital Fluid

 Pad Glass

 Sine B Portapad

 Verseau

  

Pluck

 Cold Pluck

 Crystal Guitar

 Dulce Major

 Flutata

 Fretted Space

 Generation X

 Gorilla Frets

 Hard Mute Guit

 Hardmonix

 Hybrid Pluck

 K5oto

 Little Slap

 PCorn Acid Box

 Pluck Vox

 Resistance

 Retro Phasing

 Softy Plucky

 Stack Atoh

 Steam Reso

 Steel Detuned

 Stratadditive

  

Polysynth

 Cyber Flute

 Dirty Stack

 Eurotek

 Five Stars

 Lauper Synth

 Magic Flute

 Modularium

 Polysynth K5S

 Ravage

 Rave Party

 Raw Saw

 Soft Poly

 Space Metal

 Sweepoly

 The Snake

 Zapp Poly Mood 

  

Strings

 Claustrochestra

 Dark Ensemble

 Electro Strings

 Four Pieces

 Left and Right

 Modularium Cordes

 OB Strings

 Simple Wave

 Space Orchestra

 Synth Strings

 Very Soft Strings

  

Sweeps

 Add Glasssweep

 Frequency Browser

 Gentel Lay

 Heartificial

 Multipolaire

 Reversweep

  

Vocals

 Dark Space 1

 Dark Space 2

 Fair Pad

 Full Light

 Mello Space

 Moon Chorale

 Pizzi Voices

 Porta Vox 1

 Porta Vox 2

 So 90s

 Stackoirs

 Synthetic Motion

 Vocabass

 Vox Bell Pad

 Xylo Voices
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DS-890 - Interface

2Amplitude

3Filter

6Stereo

4 Pitch

1 Mono / Poly

7 Bit Crusher

5 Drive

8 Effects

9 Modwheel

1  Mode
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel > Atk

Remaps Attack to Note Velocity

» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filter envelope

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento

» Time

Sets the glide time

5  Drive
» On/Off Switch

» Amount

Sets the drive amount

6  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [Width]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width (ALT mode)

» Detune

Detunes the unison layers (UNI mode)

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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DS-890 - Preset List

Bass

 Extravaganza

 Funk Wah Cool

 Funk Wah Hard

 Garage Bass

 JBBass

 JD Bass 1

 JD Bass 2

 JD Bass 3

 Neon Bass

 OBassheim

 Pizz DBass

 RoomBasstic

 Slap Man

 Stack Bass

 Straight Bass

 Ultra Bass

 VerBass

  

Bells

 890 Bell 1

 890 Bell 2

 890 Bell 3

 ComplexBells

 Cryptonic Bells

 Epic Bells

 JDX Bells

 Long Island Bells

 Loon Ease

 Macro Bells

 Mystic Bells 1

 Mystic Bells 2

 Process Bells

 Steel Drumy

  

Brass

 Amex Brass

 Analog Horns

 Brass Atitude

 Brass Matic

 Dry Brass

 Embouchure

 Golden Sands

 Jedi Brass 1

 Jedi Brass 2

 Jedi Brass 3

 Large Syn Brass

 Majesty Brass

 Mello Dark

 Pure OB

 Revenge Helis

 Stack Brass

 Wind Brass

  

Keyboards

 Acoustic Piano

 Big Church

 Broken Piano

 Diganalog

 Dr Miles

 Dream Road

 Dream Tines

 Electronic One

 GospOrgan

 Jazz Oganic

 JD Clavinet

 Judi Wurli

 Old Rgan

 Piano Sympathi

 Power Piano

 Room Clav

 TechnoKeys

 Vintage Ac Piano

  

Leads

 890 Lead 1

 890 Lead 2

 Analog Solo

 Big Five

 Dry Lead

 Flutty Solo

 Funk Wah Lead

 Funky Rose

 JD Solo Two

 Screaming Lead

 Slap Man Lead

 Stack Solo

 Synchonanbourg

  

Pads

 Clould NL

 Coton De Soie

 Demoniak

 Evapore

 Evolving

 FX Pad

 Glass Vox

 Linear Pad

 Long Island Pad

 Macro Pad

 Meditation

 Nimbus

 Octave Pad

 Ominous Fair

 Organix

 Pluck Pad

 Randomish Pad

 Space Flute

 Stress Pad

 Tron Winds

 Up To Pad

 Vox Bax

  

Pluck

 Africa Yanni

 Clean Mallet

 Dulci Madre

 Guitar Scream

 Hypra Melody

 Mall Street

 Movin Harp

 New Age Lead

 Pizz Voices

 Pizza Stack

 Scream Guitar

 Soft Harp

 Syn Scream

 Ultra Pluck

 Valise

 Polysynth

 Analopoly

 Disto One

 Doctor Dro

 Euro Rythmic

 Hardcore Poly

 Philadelphia

 Power Poly

 Stack Poly

 Stellar Mello

 Syn Poly 1

 Syn Poly 2

 Ultra Fat

  

Seq

 JD Seq Three

 Large Pop Corn

 Mini Mallet

 Perco Sine

 Short Keys

 Very Shorty

  

Strings

 Aqueous Strings

 Full Orchesta

 Instable Strings

 JD Sole INA

 Large Strings

 Little Solina

 Magic Orchestra

 More Than Large

 Ouverture

 Pure Analog

 Smooth Cordes

 Solinex

 Stack Orchestra

 Strings Of Jedi

  

Sweeps

 Air Sweep

 Elephantus

 Mandala Sound

 Mellow Sweep

 Smoothies

 Stack Sweepad

 Sweep Keys

 Thorusing

 Ultra Fat Sweep

 Vox Belly

 Whispering

  

Vocals

 Ample Fair

 Attack Fair

 Beauty Vox

 Bella Choir

 Cloudosphere

 Cymbalo Pad

 DFifty Cents

 Fairmont Hotel

 JairDlight

 JD Light Fair

 Key Vox

 Munichoir

 Phasor Winds

 PNL Voices

 Sehr Soft

 Smooth Choir

 Vox Affair

 Voxhimer

 Voxynth

 Windy Vox
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Links

UVI

Home                                                                                     uvi net/ 

Soundbank Installation Guide                                                         installing_uvi_soundbanks_en pdf 

UVI Workstation User Guide                                                           uviworkstation_user_guide_en pdf 

Your Registered Product Serial Numbers and Download Links                  uvi net/my-products 

FAQ                                                                                       uvi net/faq 

Tutorial and Demo Videos                                                             youtube com/

Support                                                                                   uvi net/contact-support 

iLok

Home                                                                                     ilok com/ 

iLok License Manager                                                                  ilok com/ilm html 

FAQ                                                                                       ilok com/supportfaq 

http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/#!license-manager
https://www.ilok.com/#!faq
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